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YOUR MINIMUM VIABLE WEBSITE:

How TO CHOOSE THE BEST THEME
FOR YOUR RAINMAKER SITE

PRESENTED BY JEROD MORRIS AND RAFAL TOMAL
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Rafal Tomal

* [ ead Designer at Rainmaker Digital

 Founder of Typespiration.com

* Co-Founder of HackYourDesign.com
(with Chris Garrett)

* Author of The Essential Web Design
Handbook

* Proud father of Emilia

e @Raftallomal
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Rafal's First Point
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“When you choose a Rainmaker
theme, you don’t have to worry.”
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Design with
Rainmaker
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Design with
Rainmaker

// + AddNew @ Edit  Manage © Help £ 2

% Greetings, Jerod Morris

>

Themes

- 30+ StudioPress themes il e vecouere N

Welcome to my Website

CENTRIC

erod-morris.preview 11 1. rmkr.net/admin/themes.phpi
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Design with
Rainmaker

¢¢ + AddNew & Edit  Manage © Help 8 Greetings, Jerod Morris

>

Themes

e 30+ StudioPress themes il s vecomra SN

- HTML5 / Mobile Responsive

Fremane Vasen | rare CONEaCT rain . van S

BEST SELLING
AUTHOR

Welcome to my Website

CENTRIC

Be the Center of Attention
and Demand Focus

g PR @ Teed TR el i Vi e ) Mg P e bt s ey

erod-morris.preview 11 1. rmkr.net/admin/themes.phpi
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Design with
Rainmaker

¢¢ + AddNew & Edit  Manage © Help 8 Greetings, Jerod Morris

>

Themes

e 30+ StudioPress themes il s vecomra SN

« HTMLS / Mobile Responsive

- No coding required ... ECNEE o e

Welcome to my Website BEST SELLING
\Ale iy AUTHOR

CENTRIC

Be the Center of Attention
and Demand Focus

g P @ T TR Ol A Vi e | Mg T e btk ey

P
2 \

erod-morris.preview 11 1. rmkr.net/admin/themes.phpi
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Design with
Rainmaker

¢¢ + AddNew @ Edit /# Manage © Help

8¢ Greetings, Jerod Morris

Themes

e 30+ StudioPress themes e ey
|

« HTML5 / Mobile Responsive

 No coding required ...

BEST SELLING -
AUTHOR o

- ... but easy to add custom
CSS
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Design with
Rainmaker

¢¢ + AddNew @ Edit / Manage © Help -‘-' Greetings, Jerod Morris

Themes

® 30—|— StUdK)PreSS themes Active: Rainmaker Pro
« HTML5 / Mobile Responsive

 No coding required ...

BEST SELLING -
AUTHOR o

e ... but easy to add custom
CSS

- Checked for accessibility

77 RAINMAKER PLATFORM
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Design with
Rainmaker

¢¢ + AddNew & Edit /# Manage © Help -‘-‘ Greetings, Jerod Morris

Themes

® 30—|— StUd|OPreSS themes Active: Rainmaker Pro
« HTML5 / Mobile Responsive

 No coding required ...

BEST SELLING
AUTHOR

e ... but easy to add custom
CSS

e Checked for accessibility

Custom Genesis designs

allowed (upon approval) 77 RAINMAKER PLATFORN



“You don’t have to make any quality
compromises. All you have to worry
about is which theme is right.”
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A QU
Quick Tip to Start

7,
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rainmakerplatform.com/gallery
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7/ RAINMAKER PLATFORN

MENU

%

LOG IN START WITH 14 DAYS FREE

rainmakerplatform.com/gallery = Examples £ Themes

With Just a Click, Change Your
Website's Look and Feel

Never again waste time finding a theme, installing it, trying to configure it, seeing it isn't quite right

and backing out. With Rainmaker, switch between 30+ themes with a click. And customize each

to your heart’'s content. Design details —

MOST POPULAR FOR ONLINE FOR CONTENT FOR SERVICE ALL
TRAINERS & MARKETERS PROVIDERS
COACHES

77 RAINMAKER PLATFORM



% RAINMAKER PLATFORM = wen .

MOST POPULAR

rainmakerplatform.com/gallery

PARALLAX PRO

SAMPLE TYPOGCGRAPHY COLORS CONTACT

Hello Amazing.

The most beautiful theme for the Genesis Framework.

Mobile responsive in design and boasts HTMLs markup.

CONTINUE READINC

Parallax Pro Cafe Pro

77 RAINMAKER PLATFORM




7/ RAINMAKER PLATFORN

MENU

%

LOG IN START WITH 14 DAYS FREE

rainmakerplatform.com/gallery = Examples £ Themes

With Just a Click, Change Your
Website's Look and Feel

Never again waste time finding a theme, installing it, trying to configure it, seeing it isn't quite right

and backing out. With Rainmaker, switch between 30+ themes with a click. And customize each

to your heart’'s content. Design details —

MOST POPULAR FOR ONLINE FOR CONTENT FOR SERVICE ALL
TRAINERS & MARKETERS PROVIDERS
COACHES
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| ‘E@: M G ABOUT SERVICES WORK WITH JESSE BLOG
3

. Petersen Meda Group

CREATING QUALITY OVER QUANTITY SINCE 2009

Altitude Pro
an original endorsed Genesis framework developer

highly effective, proven educator

SCROLL DOWN

Sign up now for Bootstrap Your WordPress Business - a pre-recorded webinar. Goming April 2016.

what | do: what you came here for

WORDPRESS DEVELOPMENT GENESIS CHILD THEMES LEARNING

77 RAINMAKER PLATFORM



CONTACT MEMBER LOGIN

Magazine Pro

FEATURED ARTICLE

FREE
COURSE

BLOG BUSINESS BOOST
*GAIN CLIENTS

*BOOST VISIBILITY + SHARES
*SUPERCHARGE YOUR SEO

DON'T MISS THESE POSTS

JOIN HERE

Hate Selling? Do These 7
Things Instead Plus Free
Checklist!

Hate Selling? Do These 7 Things Instead Plus Free Checklist! | 2 S

77 RAINMAKER PLATFORM



ABOUT NEWSLETTER INSIGHTS CONTACT

%
@ boutique growth

Altitude Pro Take your professional services
business to the next level.

Get the very best advice, strategies and insights to grow your firm delivered straight

to your inbox, every week.
E-Mail Address

JOIN US

~g : DUCT TARE
et m\m(ETI
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Cafe Pro

ABOUT SERVICES BLOG PORTFOLIO CONTACT LOGIN

77 RAINMAKER PLATFORM



Enterprise Pro

WEBSITES R E RIS WORK WITH ME BLOG ABOUT

UVICE i on
iCial media, you get pu  JRY (
you 1to N adv g -and eho
\l"'l" ( £ [’ _“ < TE 2l ""i)'l’j“y' [«
y UL 1T L _E__ L‘ al iICald W

Are you unsure of where to start with your

marketing?

C rap Y our r\']‘_:: :—J tart ’-.—- J | ge 1o M arket :\’ esearch

and nimn <tart uvrvir markatino ramnaions Find
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Education Pro

Facebook Twitter Instagram Linkedin

LlVOLOGY About Livology Book Daily Livit Free Mini-course Blog Contact Us
The Study of Living Deliberately

U.S. National Parks:
America's Cathedrals

Wilderness and the idea of wilderness is
one of the permanent homes of the
human spirit. - Joseph Wood Krutch In
1872, Yellowstone became the ...

Continue Reading -

LIVE MORE DELIBERATELY

We've been traveling the world in order to offer you

Mf\f\v‘\lv‘\ﬂ‘lll f\"'f\l"lhf\ AV\IJ IJI'\II\I V'I\MIV'\IJI\PA IL\I‘\II\IIIII
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copywritematters HOME START HERE BLOG MY STORY MEMBERS

only the right woeds work

Parallax Pro IT'S TIME TO DECIDE

Do you want to keep writing average copy that nobody cares about? Or

Learn to write copy that earns $S$$
Propel your copywriting from good to GREAT
Discover shortcuts so you can write faster

77 RAINMAKER PLATFORM
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Adenda

7,
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Adenda

Start with content

7/ RAINMAKER PLATFORM
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Adenda

Start with content
|[dentify your brand's feeling
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Adenda

Start with content
|[dentify your brand's feeling

+ [weak the theme to fit the feeling
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Adenda

Start with content
|[dentify your brand's feeling

+ [weak the theme to fit the feeling

Rafal's favorites
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Adenda

Start with content
|[dentify your brand's feeling

+ [weak the theme to fit the feeling

Rafal's favorites
Demo showing the versatility of
RainMmaker themes

7/ RAINMAKER PLATFORM
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Start with Content

7,
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Step One: Pick a Basic Theme (Rainmaker Pro)

77 RAINMAKER PLATFORM
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Step One: Pick a Basic Theme (Rainmaker Pro)

// 4+ AddNew 2 Edit /& M:

& .
Design

| Themesh

Appearance

Menus

Content Areas

Responsive Slider
Dynamic Sidebars
Custom €SS

Maintenance Mode
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Step One: Pick a Basic Theme (Rainmaker Pro)

/& + AddNew @ Edit / Manage @ Help

74 + AddNew 2 Edit F M ®
Themes

& .
Design

| Themes_

Active: Rainmaker Pro WELCOME-TO OUR AGENCY.

Theme Details

Appearance
Menus
Content Areas

Ambiance Pro

Responsive Slider

Dominate Your Market with
the Rainmaker Platform

Theme Details

Dynamic Sidebars
Custom CS5

A e

Maintenance Mode




Step One: Pick a Basic Theme (Rainmaker Pro)

WANNA GET STRONGER?

STRATEGIC ATHLETE START HERE KNOWLEDGE TRAINING PROGRAMS 21-DAY FREE TRIAL

r—v

YOESYOURCURRENT WORKOUT
PROGRAM NEED AN PG RADE?

Workout programming, coaching, and resources for those who

depend on their fitness.

START HERE

R PLATFORM
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Step Two: Use the Sample Posts & Pages
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Step Two: Set up Sample Posts & Pages

// + AddNew 2 Edit / Manage © Help

éé + AddNew 2 Edit / Manage @ Help

; ?*

Rainmaker comes D
X _ » AgeS
A POStS with sample posts 5

-4

and pag es All (13) | Published (12) | Draft(1) | Trash(1) | Sort by Order
|
All (2) | Published (2) | Trash (3)
Bulk Actions Apply All dates Filter
Bulk Actions Apply All dates All categories Filter
Title
Title About
This is a test post. Affiliate Area
Example Blog Post Archives
Blog
Title
Checkout
Bulk Actions Apply

Contact




7%
Step Three: Create Samples Specific to Your Content

Go beyond just the
sample posts and pages.

77 RAINMAKER PLATFORM



7%
Step Three: Create Samples Specific to Your Content

Project into the future.
Are you going to have ...

 ADblog?
A podcast?
* A course?

e Products?

77 RAINMAKER PLATFORM



7%
Step Three: Create Samples Specific to Your Content

Project into the future.
Are you going to have ...

 ADblog?

A podcast?

. A course? _ Need a theme
' with a sidebar.

e Products?

77 RAINMAKER PLATFORM



7%
Step Three: Create Samples Specific to Your Content

Some elements you may
want to demo ...

* Your headlines (long or short?)

* Your writing style (long
paragraphs or short?

* Hero Images

* Post and featured images

77 RAINMAKER PLATFORM
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Look how
different this
site’s post COSEEE
setup is ... The Power of a

*GAIN CLIENTS

*BOOST VISIBILITY + SHARES PiCture

*SUPERCHARGE YOUR SEO
FEBRUARY 12, 2017 by JEN DZIUVENIS

— Leave a Comment

DON'T MISS THESE

POSTS
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Q boutique growth ABOUT PODCAST PLAYBOOK m

AHMAD MUNAWAR / DECEMBER 16, 2016

... from this site. These 5 Fqctors
Determine How Much
You Can Charge

The more you charge for your services, the more money you'll make.

But you can't simply raise your prices indiscriminately. If you do that,
without justifying the increase, you'll lose more business than you'll

gain.

[f you want to raise your prices, start by looking at the factors that



“You can always change your theme later ...
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“You can always change your theme later ...
but the best practice is to plan ahead.”

77 RAINMAKER PLATFORM



“You can always change your theme later ...
but the best practice is to plan ahead.”

“So you don’t choose your theme, spend time designing It,
then realize it doesn’t match your content.”

77 RAINMAKER PLATFORM



Step Four: Choose Your Theme

After you have
sample content
ready to go.

77 RAINMAKER PLATFORM
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Step Four: Choose Your Theme

+ Add New 2 Edit & Mz

Design

| Themesh

Appearance

Menus

Content Areas

Responsive Slider
Dynamic Sidebars
Custom €SS

Maintenance Mode

77 RAINMAKER PLATFORM



Step Four: Choose Your Theme

+ Add New & Edit # Manage ©® Help

Themes

Active: Rainmaker Pro WELCOME

We bring ideas to Me the

TO OUR AGENCY.

eative des'gn 0luno

Theme Details

Ambiance Pro

Dominate Your Market with .
Ral | Theme Details
the Rainmaker Platform

L L

Demo Live Preview
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Step Four: Choose Your Theme

/¢ + AddNew @ Edit / Manage @ Help

H >

Themes
You have 30+ theme choices

available with the click of a
button. Demo them. Preview
them. “Try them on.”

Active: Rainmaker Pro WELCOME-TO OUR AGENCY.

Theme Details

Ambiance Pro

Dominate Your Market with
the Rainmaker Platform

Theme Details

L L

_Author TYPOGRARMY  SAMAEPAGE  CONTACTRAGE  BUYTHE HEME
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Step Four: Choose Your Theme

+ Add New & Edit # Manage ©® Help

Themes
You have 30+ theme choices

available with the click of a
button. Demo them. Preview
them. “Try them on.”

Active: Rainmaker Pro WELCOME-TO OUR AGENCY.

Theme Details

Or you can submit a custom
Genesis theme for review.

Ambiance Pro

Dominate Your Market with .
> Ra Theme Details
the Rainmaker Platform

_Author TYPOGRARMY  SAMAEPAGE  CONTACTRAGE  BUYTHE HEME




But before you start customizing your theme’s
style, you need to decide what your theme’s style
will be — what feeling you want your site to evoke.

77 RAINMAKER PLATFORM
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|[dentl
tify Your Brand's Feelin
9
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“Think like your customers.
Make them feel at home.”

77 RAINMAKER PLATFORM



Create a Mood Board

Collect random images that you feel
are associated with your brand.

e Pinterest

* Pictures, color schemes, words, styles
 Show mood board to team to get

everyone on the same page

77 RAINMAKER PLATFORM
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b N e £ W s fu .?;
Create your free wedding website h an d ma d e € 2

T s ———— S~ ———— vﬁvﬂ—m‘-\-’- -~

2y

/
J

Gl »F

T ———",
SEARCH

"ACTION BUTTON

gsweet
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RAINMAKER PLATFORM

%



Now you’re ready to make basic customizations.

77 RAINMAKER PLATFORM
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Twegk the Theme to
-1t the Feeling

7,
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Step One: Go to the Appearance Editor
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Step One: Go to the Appearance Editor

é/ + AddNew 2 Edit /# Manage

& .
Design

Themes
| Appearanceh
Menus

Content Areas

Responsive Slider
Dynamic Sidebars
Custom CS5

Maintenance Mode

77 RAINMAKER PLATFORM
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+ Add New V74

Design

Themes

| Appearance

Menus

Content Areas

Responsive Slider
Dynamic Sidebars
Custom CS5

Maintenance Mode

Edit

Step One: Go to the Appearance Editor

# Manage

X

You are customizing

Primility
Favicon
Colors

Header Image
Backstretch Image
Background Image
Menus
Content Areas
Home & Posts Display
Site Layout
Breadcrumbs
Comments
Content Archives
Entry Options
Footer Options

Scripts

© Collapse

PRIMILITY

Here is a good place for a call to action.

GRAB ATTENTION

This'is a good place to grab attention. Use a small piece of copy

to lead your visitor to want to find out more.

MORE ABOUT US

OUR THOUGHTS

What is your company
philosophy? Why should
we be interested in you?

SERVICES

What do you do? Why is
that beneficial? What

gives your company the

ardiinmtana?

NEWSLETTER

Your email newsletter is
a valuable asset. Get
people to sign up by

~ffAavimnea inrAantivinacl
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+ Add New V74

Design

Themes

Appearance

Menus

Content Areas

Responsive Slider
Dynamic Sidebars
Custom CS5

Maintenance Mode

Step One: Go to the Appearance Editor

X
Edit # Manage

You are customizing
Primility
Favicon

Colors

Header Image

Backstretch Image

q

Background Image
Menus

Content Areas

Home & Posts Display
Site Layout
Breadcrumbs
Comments

Content Archives
Entry Options

Footer Options

Scripts

© Collapse

PRIMILITY

Here is a good place for a call to action.

GRAB ATTENTION

This'is a good place to grab attention. Use a small piece of copy

to lead your visitor to want to find out more.

MORE ABOUT US

OUR THOUGHTS

What is your company
philosophy? Why should
we be interested in you?

SERVICES

What do you do? Why is
that beneficial? What

gives your company the

ardiinmtana?

NEWSLETTER

Your email newsletter is
a valuable asset. Get
people to sign up by

~ffAavimnea inrAantivinacl



Step Two: Change Your Colors

77 RAINMAKER PLATFORM



Customizing

Colors

Background Color

Select Color

Accent Color

- Select Color

Step Two: Change Your Colors

PRIMILITY

Here is a good place for a call to action.

GRAB ATTENTION

HOME ABOUT

LIBRARY CONTACI

Thisis a good place to grab attention. Use a small piece of copy

to lead your visitor to want to find out more.

MORE ABOUT US

OUR THOUGHTS

What is your company

mhilAacAarnIyvw D \ A lyvw el Al A

SERVICES

What do you do? Why is

Aarmaficiald \WIL oA+

NEWSLETTER

Your email newsletter is

o vszalhiisnivla scent ot

MAKER PLATFORM



Step Two: Change Your Colors

X Save & Publish

Customizing
Colors Add
Background Color heX
Select Color cod e

Accent Color

- Current Color #cd27 Default

t

PRIMILITY

MORE ABOUT US

OUR THOUGHTS

What is your company

Here is a good place for a call to action.

GRAB ATTENTION

to lead your visitor to want to find out more.

SERVICES

What do you do? Why is

Thisis a good place to grab attention. Use a small piece of copy

NEWSLETTER

Your email newsletter is

MAKER PLATFORM



Step Two: Change Your Colors
X Here is a good place for a call to action.

Customizing

. - . Add PRIMILITY HOME  ABOUT  BLOG
Pro tip: Use a digital
Background Color hex

color meter to identify code
the hex code of any A-c.
color on your screen.

GRAB ATTENTION

This'is a good place to grab attention. Use a small piece of copy

to lead your visitor to want to find out more.

Digital Color Meter
Version: 5.10 MORE ABOUT US

OUR THOUGHTS SERVICES NEWSLETTER

What is your company What do you do? Why is Your email newsletter is



Step Two: Change Your Colors

X Save & Publish

Customizing

Colors

Background Color

Select Color

Accent Color

- Select Color

You can preview your
changes on different
pages before saving.
(Click links in
Appearance browser.)

Here is a good place for a call to action.

PRIMILITY HOME  ABOUT

YOU ARE HERE: HOME / BLOG

This is a test post.

FEBRUARY 6, 2017 BY JEROD MORRIS — LEAVE A COMMENT (EDIT)

This is some text for the post.

FILED UNDER: UNCATEGORIZED

Example Blog Post

JANUARY 1, 2000 BY JEROD MORRIS — 1 COMMENT (EDIT)

BLOG

LIBRARY CONTACT

EMAIL NEWSLETTER

Your email newsletter is
a valuable asset. Get
people to sign up by

offering incentives!

Your Email Address...

SICN UP

RECENT POSTS

This is a test post.

Example Blog Post

SOCIAL ICONS

MAKER PLATFORM
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Step Three: Change the Backstretch/Background Images
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Step Three: Change the Backstretch/Background Images
X Here is a good place for a call to action.

Customizing

Backstretch Image PRIMILITY

Use the included default image or
personalize your site by uploading your own
image for the homepage widget
background.

The default image is 1200 x 675 pixels.

Backstretch Image Upload

GRAB ATTENTION

This'is a good place to grab attention. Use a small piece of copy

to lead your visitor to want to find out more.

Remove Change Image MORE ABOUT US

OUR THOUGHTS SERVICES NEWSLETTER

77 RAINMAKER PLATFORM
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Step Three: Change the Backstretch/Background Images
X Here is a good place for a call to action.

Customizing

Backstretch Image PRIMILITY

Use the included default image or
personalize your site by uploading your own
image for the homepage widget
background.

The default image is 1200 x 675 pixels.

Backstretch Image Upload

GRAB ATTENTION

This'is a good place to grab attention. Use a small piece of copy

to lead your visitor to want to find out more.

Remove Change Image MORE ABOUT US

OUR THOUGHTS SERVICES NEWSLETTER

77 RAINMAKER PLATFORM
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Step Three: Change the Backstretch/Background Images
X Here is a good place for a call to action.

Customizing

Backstretch Image PRIMILITY

Use the included default image or
personalize your site by uploading your own
image for the homepage widget
background.

The default image is 1200 x 675 pixels.

Backstretch Image Upload

GRAB ATTENTION

This'is a good place to grab attention. Use a small piece of copy

to lead your visitor to want to find out more.

Remove Change Image MORE ABOUT US

OUR THOUGHTS SERVICES NEWSLETTER

77 RAINMAKER PLATFORM



Step Three: Change the Backstretch/Background Images

Select Image

Upload Files  Media Library

ATTACHMENT DETAILS

=N ~
Coloradotrip)uly2006065copy4.jpg
February 20, 2017

194 kB

1200 x 673

Edit Image

Delete Permanently

URL  http://jerod-morris.preview’
Title  Colorado trip July 2006 065 «

Caption

Alt Text

Description

MAKER PLATFORM

Choose Image




%

Step Three: Change the Backstretch/Background Images
X Here is a good place for a call to action.

Customizing

Backstretch Image PRIMILITY

Use the included default image or
personalize your site by uploading your own
image for the homepage widget
background.

The default image is 1200 x 675 pixels.

s B
_GRAB ATTENTIGN.\ i _

N
oodMU;e a small pi of copy

e,
to Iead your visitor to fo want to find out™

Backstretch Image Upload

MORE ABOUT US

‘wn
&,4.

OUR THOUGHTS SERVICES NEWSLETTER

77 HRAINMAKER PLATFORM
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Step Three: Change the Backstretch/Background Images
X Here is a good place for a call to action.

Customizing

Backstretch Image PRIMILITY

Use the included default image or
personalize your site by uploading your own
image for the homepage widget
background.

The default image is 1200 x 675 pixels.

P
_GRAB ATTENTIGN»_& X

f oodMU;e a small pi

to lead your visitor to want to find out®™

Backstretch Image Upload

0
my»e,

MORE ABOUT US

{gﬁ?r -
)

OUR THOUGHTS SERVICES NEWSLETTER

77 KAINMAKER PLATFORM



Step Three: Change the Backstretch/Background Images
X Here is a good place for a call to action.

Customizing

Backstretch Image PRIMILITY

Use the included default image or
personalize your site by uploading your own
image for the homepage widget
background.

The default image is 1200 x 675 pixels.
Backstretch Image Upload - - e o
| GRAB ATTENTION._ «* N W

o

Sy

Thisiis.a good place to grabattention. Use a small piece of copy

to lead your visitor to want to find out more.:

Remove Change Image MORE ABOUT US

OUR THOUGHTS SERVICES NEWSLETTER

77 RAINMAKER PLATFORM



Step Four: Change the Header Image
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Step Four: Change the Header Image

X Save & Publish

Customizing

Header Image

While you can crop images to your liking
after clicking Add new image, your theme
recommends a header size of 200 x 60
pixels.

Current header

No image set

Here is a good place for a call to action.

PRIMILITY

= GRABATTENTION. «* s,

s

v,

‘5*\

Thisiis.a good place to grabattention. Use a small piece of copy

to lead your visitor to want to find out more:

MORE ABOUT US

OUR THOUGHTS SERVICES NEWSLETTER

7z SAINMAKER PLATFORM



Step Four: Change the Header Image

Choose Image

Upload Files Media Library

Suggested image dimensions: 200 x 60

ATTACHMENT DETAILS

Primilitycopy.png

Pnl MIlI“ February 20, 2017

URL
Title

Caption

Alt Text

Description

13 kB
350 x 117

Edit Image

Delete Permanently

http://jerod-morris.preview’

Primility copy

INMAKER PLATFORM




Step Four: Change the Header Image

Crop Image

77 RAINMAKER PLATFORM



Step Four: Change the Header Image
;

Customizing

Header Image

Here is a good place for a call to action.

While you can crop images to your liking
after clicking Add new image, your theme
recommends a header size of 200 x 60
pixels.

Current header

NDDIRAI ITV

Hide image Add new image

GRAB ATTENTION_ «*

| Sy

This.is.a good pIaEe' to grab atteftion. Use a small piece of copy

Previously uploaded
to lead your visitor to want to find out more:

MORE ABOUT US

73S Randomize uploaded headers

OUR THOUGHTS SERVICES NEWSLETTER

7z sAINMAKER PLATFORM



Step Five: Edit Content Areas
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Step Five: Edit Content Areas
X Here is a good place for a call to action.

You are customizing e
Primility
Favicon >
Colors >
Header Image >
Backstretch Image > - < ~
.o
Background Image > GRAB ATTENTION._ «* N N
-\
Menus > __a . T R St
This.s.a good place to grabrattention. Use a small piece of copy
ontent Areas . :
q ’ to lead your visitor to want to find out more:
Home & Posts Display >
Site Layout > MORE ABOUT US
Breadcrumbs >
Comments >
Content Archives >
Entry Options >
Footer Options >
Scripts >

OUR THOUGHTS SERVICES NEWSLETTER

7z nainMAKER PLATFORM



Step Five: Edit Content Areas
X Here is a good place for a call to action.

You are customizing i
Content Areas
qeefore Header >
Front Page Image 5>
Front Page Widgets >
Front Page Pricing Table >
- - s
Footer 1 5 —
GRAB ATTENTION._ «*
“m
Footer 2 > 2 o e
5 - il N ’ I "Tﬁ'—\.;
Footer 3 X Thisiis.a good place to grabattention. Use a small piece of copy

to lead your visitor to want to find out more:

MORE ABOUT US

OUR THOUGHTS SERVICES NEWSLETTER
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Step Five: Edit Content Areas

Customizing » Content Areas

Before Header

Here is a good place for a call to action.

Content area that appears before the site
header.

Text A

Title:

Content:
q Here is a good place for a <a
href="/library/">call to action</a>.

GRABATTENTION. «*  wa, &

This.is.a good plac'é’ﬂt’g'grab attention. Use a small piece of copy

to lead your visitor to want to find out more:

MORE ABOUT US

v'| Automatically add paragraphs

Remove | Close

Reorder < Add a Widget OUR THOUGHTS SERVICES NEWSLETTER

77 RAINMAKER PLATFORM



Step Five: Edit Content Areas
X Get your daily dose of Primility: click here to subscribe. h

Customizing » Content Areas

Before Header

Content area that appears before the site
header.

Text A

Title:

GRAB ATTENTION. «*  wa, &

Content:
q Get your daily dose of Primility: <a
href="/subscribe/">click here to re—— il y

subscribe</a>.

Thisis.a good place to grabrattention. Use a small piece of copy

to lead your visitor to want to find out more:

MORE ABOUT US

v Automatically add paragraphs

Remove | Close

Reorder 4+ Add a Widget OUR THOUGHTS SERVICES NEWSLETTER

77 RAINMAKER PLATFORM



Step Five: Edit Content Areas

X Save & Publish Get your daily dose of Primility: click here to subscribe.

You are customizing

Content Areas

Before Header
q Front Page Image

Front Page Widgets

Front Page Pricing Table

Footer 1

Footer 2

Footer 3

@

3 GRABATTENTION. «*  wu, o

Thisiis.a good place to grabattention. Use a small piece of copy

to lead your visitor to want to find out more:

MORE ABOUT US

OUR THOUGHTS SERVICES NEWSLETTER

77 RAINMAKER PLATFORM



Step Five: Edit Content Areas

X Save & Publish

Customizing » Content Areas

Front Page Image

Image content area on the front page.
Text: Be Meaningful. 2

Title:

q 8 Meaningful.

Content:

Learn to balance your pride and
humility so you can create lasting
meaning in the Age of Narcissism.

<a href="/blog/" class="button">Get
Started/a>

v Automatically add paragraphs

Remove | Close

Reorder 4+ Add a Widget

Cet your daily dose of Primility: click here to subscribe.

BE MEANINGFUL. - e

R

Learn,to balance .)')o

lasting meaning in t

GET STARTED

OUR THOUGHTS

ol il -
ur pride-and humility so you can‘Create

he Age of Narcissism.

SERVICES

NEWSLETTER

77 RAINMAKER PLATFORM



Step Six: Save :)
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Step Six: Save :)

Cet your daily dose of Primility: click here to subscribe.

q Save & Publish

You are customizing e
Primility
Favicon >
Colors >
Header Image >
o
Backstretch Image > - -
» N o d
Background Image > BE MEANINGFUL.-_ « s
- |
Menus > i —— — St
Learn.to balance your pride-and htumility so you can€reate
Content Areas : : . o
? lasting meaning in the Age of Narcissism.
Home & Posts Display >
Site Layout > GET STARTED
Breadcrumbs >
Comments >
Content Archives >
Entry Options >
Footer Options >
Scripts >

OUR THOUGHTS SERVICES NEWSLETTER

-~ o MAKER PLATFORM



Important Note: Be Consistent
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Take Advantage of the Live Preview Option
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Take Advantage of the Live Preview Option

44 + AddNew 2 Edit /& Manage @ Help o i Greetings, Jerod Morris

ATMOSPHERE
SAMPLE PAGE CONTACT PAGE BUY THIS THEME

BEST SELLING

Welcome to Atmosphere AUTHOR

A professionally designed mobile responsive theme

AUTOBIOGRAPHY TRAVEL INSPIRATIONAL

THEME FEATURES _
h O Tul PO o l

Beautiful Theme

was | Cafe Pro

\./ / /\AV..// / J%‘J\’\ 1

Welcome to my Website

Theme Details

Sample Post With Threaded Comments

Live Preview ! MAKER PI.ATFORM




10N

R e e SR . Y indh W l
R e e e <, — “‘ai

Preview Opt

PRIMILITY

CREATE MEANING BY BALANCING PRIDE AND HUMILITY.

Ive

L

Get your daily dose of Primility:

Take Advantage of the

You are customizing
Primility
Favicon
Background Images
Colors
Header Image
Menus
Content Areas
Home & Posts Display
Site Layout
Breadcrumbs
Comments
Content Archives
Entry Options
Footer Options
Scripts




Consider Custom CSS
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Consider Custom CSS

+ Add New Z Edit # Manage ©® Help

Design

g

Themes

Appearance

Menus

Content Areas

Responsive Slider
Dynamic Sidebars
Custom CSS

Maintenance Mode

77 RAINMAKER PLATFORM



Consider Custom CSS

// + AddNew 2 Edit / Manage ™ © Help  Clear Cache o 2 O} Greetings, Jerod Morris
o K
» Custom €55

If you're an experienced website developer who's comfortable with CSS, you can further enhance your site design using Custom CSS.

h2 {
font-size:3rem
}

h2,h3,h4,h5,h6 {

color:#232525;
font-family:"Poppins",sans-serif;
font-weight:700;

line-height:1.2;

margin:0 0 20px

}

a{ Y

Custom CSS added here will override CSS added by your theme. The links below this text area can be used to learn more about creating CSS.
Note: This tool will strip out any HTML code, expressions, invalid and unsafe code.

For help with CSS try W3Schools, A List Apart, and our own CSS documentation.

Preview Save Stylesheet »

77 RAINMAKER PLATFORM
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Rafal's Favorites
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Rainmaker Pro

Don't miss out on our latest special.

RAINMAKER TYPOGRAPHY SAMPLE LAYOUTS

SIMPLY AWESOME

Introducing the most flexible HTMLS theme ever created for
Rainmaker. With an emphasis on amazing typography and
mobile responsive design, this incredible theme will leave your

audience nothing short of speechless.

VIEW PRICING PAGE

CONTACT

CALL TO ACTION

R PLATFORM




Atmosphere Pro
ATMOSPHERE ABOUTUS OURBLOG TYPOGRAPHY SAMPLE PAGES

Welcome to Atmosphere

A professionally designed mobile responsive theme.

CLICK TO LEARN MORE

ER PLATFORM




a1 S

Altitude Pro

’ ."yc‘ v ..' . . -
PR I*L:”L(. FAQS SIGN UP CONTACT

A 6-WEEK COURSE

Dominate Your Market with
the Rainmaker Platform

SIGN UP NOW LEARN MORE

Note: Text on this page is for demonstration purposes only and does not represent an actual course.

ER PLATFORM
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Demo Sh

owing the V
. X -
of Rainmaker Therrzseastlllty
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Rainmaker Pro: Out of the Box

Here is a good place for a call to action.

RAFAL-STAGE.CBMDEVO2.RMKR.NET HOME

GRAB ATTENTION

This is a good place to grab attention. Use a small piece of copy

to lead your visitor to want to find out more.

MORE ABOUT US

OUR THOUGHTS SERVICES
What is your company What do you do? Why is that
philosophy? Why should we be beneficial? What gives your

interested in you? company the advantage?

ABOUT

BLOG LIBRARY CONTACT

NEWSLETTER

Your email newsletter is a
valuable asset. Get people to

sign up by offering incentives!

KER PLATFORM



Rainmaker Pro: Variation 1

Here is a good place for a

RAFAL-STAGE.CBMDEVO2.RMKR.NET BLOG  LIBRARY  CONTACT

OUR THOUGHTS SERVICES NEWSLETTER

What is your company What do you do? Why is that Your email newsletter is a
philosophy? Why should we be beneficial? What gives your valuable asset. Get people to
interested in you? company the advantage? sign up by offering incentives!

v

KER PLATFORM



Rainmaker Pro: Variation 2

Here is a good place for a

RAFAL-STAGE.CBMDEVO2.RMKR.NET HOME  ABOUT  BLOG  LIBRARY  CONTACT

GRAB ATTENTION;

DA
This is.a good place to grab atte 1tic

to lead your visitor to want to fif e

e nc— A
OUR THOUGHTS SERVICES NEWSLETTER

What is your company What do you do? Why is that Your email newsletter is a

philosophy? Why should we be beneficial? What gives your valuable asset. Get people to

interested in you? company the advantage? sign up by offering incentives!

KER PLATFORM



Altitude Pro: Out of the Box

~ TESTIMONIALS ~ FAQS  OURSHOP  SIGNUP  CONTACT

A 6-WEEK COURSF

Dominate Your Market with

the Rainmaker Platform

SIGN UP NOW LEARN MORE

lrext on this page is for demonstr ation purposes only ana does not represent an actual course

77 RAINMAKER PLATFORM




Altitude Pro: Variation 1

RAFAL'S RAINMAKER SITE

A 6-WEEK URSE

Dominate Your Market with

the Rainmaker Platform

77 RAINMAKER PLATFORM




Altitude Pro: Variation 2

HOME ABOUT BLOG LIBERARY CONTALT

A 6-WEEK COURSE

Dominate Your Market with

the Rainmaker Platform

LEARN MORE

LoseEs ONry and does not represent an actual course

77 RAINMAKER PLATFORM




Atmosphere Pro: Out of the Box

ATMOSPHERE ABOUTUS OURBLOG TYPOGRAPHY SAMPLE PAGES OUR SHOP PURCHASE THEME

Welcome to Atmosphere

A professionally designed mobile responsive theme.

CLICK TO LEARN MORE

77 RAINMAKER PLATFORM



Atmosphere Pro: Variation 1

RAFAL'S RAINMAKER SITE HOME ABOUT BLOG LIBRARY  CONTACT

Welcome to Atmosphere.

A professionally designed mobile responsive theme.

CLICK TO LEARN MORE

77 RAINMAKER PLATFORM



Atmosphere Pro: Variation 2

RAFAL'S RAINMAKERSITE OME ABOUT BLOG LIBRARY CONTACT

Welcome to Atmosphere

A professionally designed mobile responsive theme.

CLICK TO LEARN MORE

77 RAINMAKER PLATFORM
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Coming up ..
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Q&A on Rainmaker Design
Settings with Rafal Tomal

Wednesday, March 1 at 1:.00 p.m. Eastern Time

77 RAINMAKER PLATFORM



Q&A on Rainmaker Design
Settings with Rafal Tomal

Wednesday, March 1 at 1:.00 p.m. Eastern Time

How to Set Up and Manage
Your Rainmaker Blog
Wednesday, March 8 at 11:00 a.m. Eastern Time

77 RAINMAKER PLATFORM
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Questions?

7,
7 RAINMAKER PLATFORM



%

77 RAINMAKER PLATFORM



http://newrainmaker.com

